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Connecting and testing


The following pages will guide you in connecting your system together and running some tests before going live.  
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connecting teleforms


The system shipped from Innovative Interfaces will need to be set up upon arrival. See the below diagram on how to set up the 
system.  
 


 
 
 
Pictures of the connections may also be seen under Hardware 


After the system is set up and running, install your library's anti-virus software onto the system. Innovative 
Interfaces highly recommends that your library install the anti-virus software your library uses onto the Teleforms 
machine.  
 
To the extent possible, your library must avoid using the Teleforms PC as a staff workstation. Loading additional software onto 
the machine can slow it down and reduce its operating efficiency.  
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testing and troubleshooting


Before going live with your Teleforms system, your library should conduct some tests on your own and with 
Innovative Interfaces to make sure the system is working properly. The following pages will guide you through conducting 
these tests.  
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test using local database


To test how your recorded message(s) plays, you may use a Local Database that you need to create. You must first set up 
your dialing rules, record your messages, and fill out your message profiles. Once this is done, please complete the 
following steps to set your database to Local and then create the Calling List for your test: 


To change the database go to Edit » Configure Options and change CalllistLocation from Remote to Local (case sensitive). To 
save your change, tab to another field.  
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After the above change has been made, open the LocalCalllist program in the folder C:\Program Files\InterComp\Teleforms_D1 


Only fill in the following fields: 


●     PHONE (enter valid or invalid phone number consistent with your dialing rules) 
●     CALLSTATUS (set to "Ready") 
●     NAME (If SAYNAMEON set to True in Message Profile) 
●     MSG (must be an existing message profile, case sensitive) 
●     LASTRESULT (set to "none") 
●     ATTEMPTS (set to "0" (zero) ) 
●     ACTIVITYDATE (if SAYDATEON set to True; format MM/DD/YYYY) 


To edit rows, you may use either the tab or arrow keys. To add rows you may either tab/arrow to end of current line and 
tab again or, alternatively, use the down arrow when in the last row's PHONE field.  
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Once the Calling List is populated with information, you may open Teleforms_D and click Start (noting the Calling Times) 
to begin the test.  
 
The purpose of these tests is to listen to your messages and test for their sound quality as well as to listen for long pauses 
between the voice segments. If you are not satisfied with your messages, you may need to re-record.  
 


REMINDER


When you have completed your tests, remember to change the CalllistLocation in Options back to Remote. 
Test your connection to the Millennium server via Edit » Database Configuration » Remote Database » Test 


Connection.
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testing


After you have made the customized changes to the Teleforms software, contact Innovative Interfaces to arrange a time for 
testing on your live server. Innovative Interfaces will turn on the Teleforms software on the server and test using the 
following generic testing protocol: 


1.  Place a hold on an item. 
2.  Check the item back in at the pickup location. 
3.  Prepare only the Teleforms "Hold" notices. 
4.  Test to make sure that the Teleforms system calls the phone number in the patron record and plays the hold message. If 


a call is made and the message is played, the testing is complete. If not, Innovative Interfaces will continue to work with 
your library to resolve the issue. 


 
 
If you would like to test your dialing rules and messages prior to testing with Innovative Interfaces, you can use the Local 
Calling List to do so.  
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troubleshooting


If you need to troubleshoot on your own or prior to initial testing with Innovative Interfaces, the following are a series of 
troubleshooting tips to run through.  
 
My Calls are not being made or Teleforms is registering incomplete calls. 


There are several things to examine to solve these problems, starting with your phone lines. Is your system connected to a 
working phone line? If so, does your library have special procedures for dialing outside lines (ie dial "9" then the number) 
and are these procedures in the options menu? Are these procedures in the options menu? Is the call made but then 
immediately hangs up? If so, carefully check the syntax of the Message Profile_Code. 


I have Completed Calls but have no messages or short messages on my answering machine/voice mail. 


There are two configurations to look at when the messages are cut short by answering machines/voice mail. 


Message profile: The message profile is a setting for RepeatMSG. Make sure this is set to True. 


Sound files: Review your sound files for accuracy. If a file has been mis-recorded you may need to rerecord. 


When I prepare Circulation Notices I do not have any notices for Teleforms. 


Check your patron records. Your patrons must have a 10-digit phone number in their records. For testing, select patron records 
with Notice Preference set to Telephone. For more information how Millennium chooses delivery methods see Diagram. 


Nothing is showing up in the Teleforms table displayed or in the Calling List. What should I do? 


Did you complete your circulation notice preparation and send the notices to Teleforms? The Circulation Notices must be sent 
to Teleforms before the notices will appear in the table or the Calling List.  
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faq and help


The following pages contain Frequently Asked Questions and brief guide to the help files on your Teleforms system. 
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faq's


�❍     I'm a new Innovative Interfaces customer. When can I start running Teleforms? 


�❍     I opened some of the Teleforms files and saw many options. What can I modify? 


�❍     Why is Teleforms calling people at hours I did not set? 


�❍     The Teleforms machine looks like a regular computer. Can I use it as a staff computer? 


�❍     Answering machines and voice mails only record half the message. Is there anything I can I do? 


�❍     Do I need to click "Start" everyday? 


�❍     Does Teleforms know if a certain day is a holiday? 


�❍     What do the messages in the LastResult column mean? 


�❍     How can I make sure that an unsuccessful call is repeated in the evening? 


�❍     In the morning, do we need to do anything if there are any pending calls left over from the previous day? 


�❍     Why do I get a time violation? 


�❍     Is there a convenient way to view the number of hold pickup notices in the Teleforms client? 


�❍     I printed my Unsuccessful TNS Notices. Why are those items still displaying in Teleforms? 


�❍     If hold pickups are queued by multiple libraries after the calling has begun, do they append to the same file or do 
they wait until the following day? 


�❍     When I start up the Teleforms application, I get this pop-up: Dialogic channel is not available to place calls! Please 
start Dialogic system. 


 
 


●     I'm a new Innovative Interfaces customer. When can I start running Teleforms? 


For new Innovative Customers, all Millennium modules must be in place and working before Teleforms is installed. 
After all modules are installed, please call Innovative to have the system turned on. 


●     I opened some of the Teleforms files and saw many options. What can I modify? 


Only modify the options specified in this tutorial. Making changes to any of the other options can cause the software to 
become unstable and possibly malfunction. 


●     Why is Teleforms calling people at hours I did not set? 


Make sure that the clock on the computer is accurate. Teleforms uses the computer's clock to regulate when it should 
and should not call. Check the clock after power outages, Spring/Fall time changes, etc. Also check your time setups in 
Calling Times. 


●     The Teleforms machine looks like a regular computer. Can I use it as a staff computer? 
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If possible, never use the Teleforms computer system provided by Innovative Interfaces for anything other than its 
intended purpose. Also, do not install any major programs (such as Photoshop) onto the system. Doing so may cause 
Teleforms to not function properly. However, you should install the anti-virus software your library uses onto the 
system and keep it updated. 


●     Answering machines and voice mails only record half the message. Is there anything I can I do? 


We've seen this before, and it happens mainly because the voicemail message from the answering machine is too 
long. You can set the REPEATMSG in the Message Profile to "True." If the message gets cut-off, it will be replayed in 
its entirety the 2nd time. 


●     Do I need to click "Start" everyday? 


You don't need to click the 'start' button every day. Once you are ready to send out notices on a regular basis, all you 
need to do is set the Calling Days and Calling Times and then click 'Start'. This will take care of the weekends as well. 


●     Does Teleforms know if a certain day is a holiday? 


Teleforms does not distinguish if a weekday is a holiday or not. It only looks for the days you have checked in the 
Calling Days table. If you have a holiday coming up, you will need to click 'Stop', uncheck the day the the holiday falls 
on, then click 'Start'. Remember to change it back after the holiday. 


●     What do the messages in the LastResult column mean? 


Following the most recent attempt the LastResult will display the one of the following messages: 


 
 


PLAYED MSG: The message was played 


BUSY: A busy signal was encountered. 


INTERRUPT: Interrupt means the system encountered a phone company interrupt signal. Normally, three tones 
play and the prerecording of "the line is not in service or has been disconnected" or "all circuits are busy now, 
please try your call again later." 


MAX RING: The built in maximum number of rings has been reached and there was no answer. 


FAX: A fax machine was encountered. 


BLOCKED: The call was blocked/number was blocked. If the call should not have been blocked, recheck your 
dialing rules. 


●     How can I make sure that an unsuccessful call is repeated in the evening? 


On a smaller system, the maximum number of attempts may finish relatively early in the day. To spread out the time 
between attempts, increase the time in the AttemptDelay. See the Configure Options page of this tutorial for more 
information. Larger systems generally find that this is not an issue due to the number of calls being made as the 
greater numbers provide a natural spread of time between attempts. 


●     In the morning, do we need to do anything if there are any pending calls left over from the previous day? 


Any pending calls leftover will be sent the next operating day. Teleforms is designed to be a hands-off operation. 


●     Why do I get a time violation? 


A time violation will occur if Teleforms is started before the allowed operational times. 
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●     Is there a convenient way to view the number of hold pickup notices in the Teleforms client? 


No, but you can view this in Millennium with the feature Notices History. Please see the Innovative Guide and 
Reference Page 107241 Viewing Notice History for more details. 


●     I printed my Unsuccessful TNS Notices. Why are those items still displaying in Teleforms? 


There is a setting you may update that determines the number of days Teleforms history displays. The recommended 
number of days is 14, but it can be any number up to 365 days. Every item originally attempted as a Teleforms call 
will be included regardless of the result. 


●     If hold pickups are queued by multiple libraries after the calling has begun, do they append to the same file or do they 
wait until the following day? 


The hold pickup notices are queued up immediately and are typically eligible for calling within 5 minutes of sending the 
notices to Teleforms. 


●     When I start up the Teleforms application, I get this pop-up: Dialogic channel is not available to place calls! Please 
start Dialogic system. 


Whenever rebooting the Teleforms PC, wait 5-10 minutes before starting the Teleforms application. 
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teleforms help files


Besides this tutorial, Teleforms also contains a help file that may provide you with more information.  
 


 
 
 
When Help opens, you will see "Help" and "About". Under "Help" you will find "Windows Layout" and "How Do I..." 


"Windows Layout" contains several dropdowns (Main Window, File Menu, etc.). You may click on any of these to find more 
information for each selection. "How Do I..." provides information on performing various tasks within the system.  
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introduction


Understanding and customizing your Teleforms machine is key for the machine to operate smoothly. This tutorial is intended as 
a guide for setting up new Teleforms machines, and as a reference tool for later questions. It covers such topics as 
configuring options, recording messages, and customizing the system to make calls at the times you choose.  
 
The tutorial as a whole can be used in one of two ways. For libraries new to Teleforms, or for new library staff just beginning to 
use a Teleforms machine, this tutorial can be followed in a step-by-step manner, using the  and 


 navigation icons. Using the tutorial this way will guide you through all functions of the machine.  


 
A second way to use the tutorial, particularly suited for a department supervisor primarily interested in a certain task, is to 
use the menu based approach. Using the menu at the top of the tutorial, you can find the topic you are interested in and go 
directly there.  
 
Finally, Innovative Interfaces recommends that a copy of this tutorial be downloaded onto the Teleforms machine so it can be 
used as a reference tool when modifying any option in the Teleforms machine.  
 
Customers who would like to mount this tutorial on a local server for the use of their staff, without having to allow them full 
access to CSDirect, may download the tutorial as a ZIP file (size 1.74Mb). 
After the file has been downloaded and unzipped into the Local directory of choice you will see a list of individual html 
pages. Double click to open a page called index.html and the tutorial will be accessible.  
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navigation and requirements


●     At the bottom of each page are links to the next and previous pages. We recommend you follow through the tutorial 
steps using the Next Page links. 


●     At any time you can select from the drop down menus on the navigation bar across the top of each page. 
●     Within pages there are links to other pages in the tutorial. Use your browser's Back button to return to your previous 


place in the tutorial. 
●     Links to pages outside the tutorial open in a separate browser window. To return to the tutorial, close the external link 


window, or click on the tutorial window to make it active. 
●     Graphic examples are included on many pages. To view one, click on the text view the screen image. Images and pop-up 


messages open up a small window on the page. Close it by clicking on the button close window, or click the X button in 
the top right corner. 


●     HOT TIP is used to highlight information that either illustrates or expands a point in the tutorial text. 


recommended software and hardware settings 


●     Web browser: Netscape Communicator v.4.5 or above; Internet Explorer v.4.5 or above; Mozilla Firefox 1.5 or above 


For optimal viewing: 


●     Web browser: Netscape Communicator v.6.0 or above; Internet Explorer v.5.5 or above 
●     Monitor setting: 1024 x 768 resolution or higher, with browser window maximized 
●     Colors: at least 256 or higher 


printing 


You can print individual tutorial pages and screens from within a Web browser using the 'Print this page' icon  
 


 


The complete tutorial can also be printed in PDF format. To view and print it you need Adobe Acrobat Reader software which you 


can download from  


downloading 


Customers who would like to mount this tutorial on a local server for the use of their staff, without having to allow them full 
access to CSDirect, may download the tutorial as a ZIP file (size 4.48Mb). 


After the file has been downloaded and unzipped into the Local directory of choice you will see a list of individual html 
pages. Double click to open a page called index.html and the tutorial will be accessible. Once it has been downloaded locally, 
you may choose to open it in a web editor and insert local policies, practices or notes. 


Please note that internal links to the User's Manual will result in a "page cannot be found" error message since the tutorial uses 
a relative addressing system. However, the link reference contains the User's Manual page number, which can be 
searched within the customer Millennium server's own version of the User's Manual. 


Please contact us if you have questions, comments or problems. 
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hardware


Below are some pictures of the Teleforms system and its components. In the images below you can see the actual machine, the 
black Skutch box, the monitor, the speaker, and how some of the cables are connected. This page is not intended to 
provide instructions of the machine's setup. For a diagram of how the machine and its components are connected, please see 
the connecting teleforms page of this tutorial.  
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how teleforms works


If your library users have telephone selected as the notice preference, when you prepare circulation notices for holds and 
overdues, the Millennium system creates a list of the hold pickup and overdue notices that can be delivered by Teleforms. When 
you choose to have these notices delivered by Teleforms, the system automatically sends them to a MySQL database on the 
Innovative server using Open Database Connectivity (ODBC). Your Teleforms PC accesses the same database so that you do not 
need to manually download or upload the notices after you prepare them. You can configure your Teleforms PC so that it will 
automatically begin placing these calls at the appropriate hour. 


Teleforms notices can have one of the following statuses:  
 


Call Notice Statuses


Status Description


Ready The call is ready to be placed.


Pending The Teleforms PC is currently placing the call, or at least one attempt to place the call has 
been made.


Complete The Teleforms PC successfully placed the call.


Incomplete The Teleforms PC could not successfully place the call. The Teleforms PC will not attempt 
to place this call again.


Incompletelogged The status is changed to Incompletelogged after the unsuccessful notices have printed, if 
the Teleforms History feature is enabled.


 
The Teleforms PC automatically updates the status of each call attempt notice in the database. However, every day your library 
is open, you should print notices for undelivered Teleforms calls. When you choose this option, the Teleforms PC removes 
completed calls (i.e., those calls whose status is Complete) from the database and allows you to print those calls that it could 
not complete (i.e., those calls whose status is Incomplete). If you confirm that you successfully printed the incomplete calls, 
Millennium will remove them from the database. Calls with a status of Ready or Pending remain in the database until the 
Teleforms PC changes their status to Complete or Incomplete.  
 
A Typical Call  
 
For each call that it places, the Teleforms PC begins by taking the telephone line off-hook and listening for a dial tone. After it 
recognizes the dial tone, it dials the number. You can use the configuration options and dialing rules to specify whether 
the Teleforms PC includes area codes. The Teleforms PC can recognize most standard sounds on a phone line, such as ringing 
and a busy signal. If it recognizes just a ringing line with no answer, or a busy signal, the Teleforms PC skips to the next call 
in the list. If it recognizes a voice on the line (either a live human voice or a recording), it waits for the voice to stop 
speaking, and then delivers the appropriate message. Here are some typical messages: 


Sample Hold Pickup Message 


Hello. This is the [YourLibraryName's]. A book that a patron at this number requested is now available for 
pickup. It will be held at the library until Friday, January 5th. Please come in and pick up this item. To repeat this 
message, please stay on the line. Hello. This is the [YourLibraryName's]... 


Sample Overdue Message 


Hello. This is the [YourLibraryName's]. Our records indicate that a patron at this number has an item that is 
overdue. If so, please return them to the library. To repeat this message, stay on the line... 
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Acquiring Additional Hold Pickup Messages


By default, the Teleforms PC supports one hold pickup message and one overdue message 
only. However, your library can acquire additional hold pickup messages. For more 
information, please contact your sales representative at Innovative Interfaces.


 
 
The first time the Teleforms PC attempts to place the call, it changes the call's status from Ready to Pending. If the 
Teleforms PC is able to play the message, the call is considered "delivered" and the Teleforms PC changes its status to 
Complete. If the Teleforms PC is unable to play the message, it checks the setting of the AttemptLimit configuration option. 
If the AttemptLimit option is set to a value greater than one, the call's status remains Pending. When the Teleforms PC reaches 
the AttemptLimit for the call, the call is considered "undelivered" and the Teleforms PC changes the call's status to Incomplete.  
 
In either case, after attempting to place the call, the Teleforms PC hangs up the phone line and proceeds to the next call in the 
list. This process continues until all of the calls in the list have been attempted. At this point, the Teleforms PC reattempts to 
place calls whose status is Pending. If you prepare more Teleforms notices during the day, the Teleforms PC appends those 
notices to the list.  
 


How the Teleforms PC Prioritizes the Call List


The Teleforms PC prioritizes calls in the list using the following logic. First, it sorts the calls by 
the number of attempts made (fewest attempts first), then by how recently the last attempt 
was made (most recent last), and finally by phone number (using the phone number as a 
whole number, so 555-5555 will come before 555-5556).


 
If Teleforms cannot deliver the notices because of a bad phone number or a no-answer, the call is considered Incomplete. This 
information is stored on the Millennium server and is accessed when the library prepares notices for undelivered Teleforms 
notices. Undelivered Teleforms notices can then be printed. 
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diagram


 
 
 
* If no notice preference is selected the system default behavior will select email first, then telephone as the second option and 
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print as the last. So patrons with no changed preference who also have an email address field in their patron record will be 
sent email notices. If they have no email field, but do have an unblocked telephone number, they will receive a 
telephone notice, and only if they have no email address AND no unblocked phone number will they be sent print notices.  
 
Download PDF version here.  
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setting up the system


Your Teleforms system requires some initial setup before it can start making calls. The following pages will guide you through 
the set up.  
 


●     Sound Files 
●     Configure Options 
●     Dialing Rules 
●     Setting Calling Days and Times 
●     Message Profile 
●     Patron Records 
●     Multiples 
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sound files


Teleforms is a library product that strings together sound files to produce voice messages alerting patrons that on-hold 
items are ready to be picked up or that items are now overdue. Innovative provides two generic messages, one for holds 
and one for overdues. The next two pages of this tutorial will guide you though recording your own customized version of these 
two message(s). However, if you would like more than two messages because you have more than one possible hold 
pickup location, contact your sales representative at Innovative Interfaces.  
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sound file basics


The Teleforms PC uses wave (.wav) sound files to specify the parts of a message. When Teleforms contacts each individual 
patron, the software will take each separate audio file and string them together based on the nature of the call (overdue 
or hold) and a date (for holds only). Below is an example of how a customized holds message (with both SAYDATE and 
REPEATMSG set to True) can be put together using the sound files your library records.  
 
Hello this is the [Your Library's Name]. According to our records, someone at this phone number has an item on hold that is 
ready to be picked up. Please pick up this item from the library before Monday May, 18. If you would like this message to 
repeat, please stay on the line... Hello this is the [Your Library's Name] library...  
 
HoldSeg1.wav 
MON.wav 
MAY.wav 
18.wav 
HoldSeg2.wav 
 
 
Teleforms will arrive from Innovative Interfaces with sound files for two generic messages: one for holds and one for overdue 
notices. These messages can be used right out of the box, however your library should strongly consider recording a customized 
message for holds and overdues for its patrons. If the library would like more than the two messages, contact Innovative. 
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recording messages


If your library decides to record customized holds or overdue messages, follow the steps outlined below. Unless your library 
purchased multiple messages, you will only be able to customize one hold and/or one overdue message. If your library 
would like to purchase more messages to specify different hold locations, contact Innovative Interfaces.  
 
The software used to record your messages is called Prompt Recorder. You can access Prompt Recorder from the Teleforms Edit 
pull-down menu  
 


 
 
 
The program records via the telephone. There is no microphone for recording the message into the system. You will have to use 
a phone to record messages. The system will be used to make a call out to the person recording the messages. To do this, 
your Teleforms machine must be connected to a working phone line. The messages must be recorded and saved in wave (.wav) 
format. 


1.  From the main window, choose Edit | Prompt Recorder. 
2.  Choose a "Number to dial" and then click "connect" 
3.  Call the number and say hello or some sort of voice interaction. 
4.  Click on "file" and choose the voice file you want to change (.wav format) 
5.  Click on "record" and speak the phrase. When done click "stop" 
6.  When you click "stop" it saves the file. 
7.  You can then Play the file back to verify accuracy. 
8.  To add additional recordings stay on the line and repeat from step 5. Or, if done, simply click the close button and it will 


hangup. 
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HOT TIP - Try to keep your messages as short as possible.


 
 


Ideas for Sample Messages:  
 
Overdue: Hello. This is the ______ Library. According to our records, someone at 
this number has an item overdue. Please return the item. Thank you. [Teleforms 
does not use a date for overdues]  
 
Simple Holds: Hello. This is the ______ Library. According to our records, 
someone at this number has an item that is ready to be picked up. Please come to 
the library to pick up the item. Thank you. [Holds messages can be created 
without dates]  
 
Longer Holds: Hello. This is the ______ Library. According to our records, 
someone at this number has an item that is ready to picked up by. [Teleforms can 
fill in the date if you choose] 


Examples of messages.  
HoldSeg1.wav = Hello 
HoldSeg2.wav = This is the ______ Library. According to our records, someone at this number has an item that is ready to be 
picked up. Please come to the library to pick up the item. 
HoldSeg3.wav = Thank you. Goodbye. (or some version thereof) 
OverdueSeg1.wav = Hello. This is the ______ Library. According to our records, someone at this number has an item 
overdue. Please return the item. Thank you.  
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If you are satisfied with the recording, save your holds message as HoldSeg2.wav and your overdue message as OverdueSeg1.
wav. If you are not satisfied with it, discard the message and start again.  
 


HOT TIP - Your messages MUST be saved in the folder Voice Files. You can access this folder by clicking on File » Open 
» Voice Files. If your sound files are not saved in this folder, Teleforms will not be able find your messages to play. 


 
 
For HoldSeg3.wav, follow the steps outlined above to record a wide variety of messages such as: "Thank you. Good-bye" or "If 
you picked up in the middle of this message please stay on the line and it will repeat." Please keep in mind that HoldSeg3.wav is 
an optional message, so if your library feels that the HoldSeg2.wav message is complete (ie the short holds message sample 
above), you do not need to record a HoldSeg3.wav message.  
 


HOT TIP - You can also use the HoldSeg3.wav message to repeat the HoldSeg2.wav message in another language. 
Simply record a translation of the HoldSeg2.wav message and name it HoldSeg3.wav . However, you can only do this 
with one other language. Teleforms does not translate messages automatically, nor does it recognize a message's 
language.


 
 
If your library chooses to have Teleforms say the date that an item hold should be picked up by, you should also record months 
(January through December), days of the weeks (Monday through Sunday, excluding your library's days closed), and 
date numbers (one through thirty-one).  
 


Format Description Example


Months Combine the first three letters of the month's name (in uppercase) with 
the .wav extension. DEC.wav


Days of the Month Combine the number of the day with the .wav extension. Note that these 
numbers must be represented by two digits (e.g., use 03.wav not 3.wav).


14.wav 
03.wav 
28.wav


Days of the week Combine the first three letters of the weekday's name (in uppercase) with 
the .wav extension. TUE.wav


 
 
If your library has purchased additional messages for more than one pick-up location, your library should also record a 
holds message for each pick up location. This audio file should be named based on its TNS Location Map code. Teleforms 
selects the message to play based on this code. See Multiple Messages for more information. After all your additional messages 
have been recorded, refer to the Message Profile page to construct the string of audio files to be played for this location served.  
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configure options


Before the system can start calling patrons, your library must configure certain system options. If your Teleforms machine is 
already running and you would like to change some options, you will need to stop calls (click Stop button found under Current 
Status) before changing options. You can find these options in the Teleforms Edit drop-down menu under Configure Options.  
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In the System Configuration Options menu that appears, you will see a list of options. Because the window to view these options 
is fixed, you can scroll to the right to view a very brief description of each option. After making the change, tab through to make 
the change permanent. Innovative recommends that you configure or change ONLY the following options on your 
own. Changing any of the other listed options may cause your system to become unstable and not work properly.  
 
Attempt Delay Enter the number of minutes you would like the Call Manager to be idle between attempting the same phone 
number. If the number of calls your library is making per day is relatively low, so that all calls finish in the morning, 
for example, then set this number fairly high. Unless there is a very high volume of calls, a low number can potentially attempt 
to call a patron several times during a short time period.  
 
Attempt Limit Enter the number of times you would like Teleforms to attempt dials before a call is considered incomplete. 
If you set this number to 3, Teleforms will attempt to dial three times before listing the call as incomplete. Notices for 
incomplete calls can then be printed.  
 
CalllistLocation This option has two choices Remote and Local (case sensitive) and is changed only during testing. The setting 
for a Teleforms PC running on a live Millennium server should be Remote.  
 
Global Prefix Enter the number (or code) the library uses to connect to an outside line. Many organizations use the number 9. 
You can also ask Teleforms to pause for a split-second before dialing by placing a comma in this cell, ie: 9, means Teleforms will 
dial 9 then pause for a split second before dialing.  
 
Portloca The portloca value corresponds to the entries in the Locations Served table. If your library has only one Teleforms PC, 
this option should be set to 0 (all Locations Served). If your library has more than one Teleforms machine, see 
Multiple Machines.  
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dialing rules


Teleforms uses dialing rules for the library's policies on how to call patrons. Dialing rules can block long distance calls from being 
made and specify which exchanges within an area code should or should not be called. Before modifying the dialing rules on an 
existing machine, stop calls (click Stop button found under Current Status).  
 
Under the Edit drop-down menu choose dialing rules.  
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The first step in Dialing Rules configuration is to decide whether your library wishes to block all (or most) long-distance calls. If 
so, you can block calls for all area codes at once by checking the box for "Block Long Distance Calls" and clicking OK. This will 
set the "Block Call" element to "true" for every area code and exchange in the table. (Likewise, you can unblock calls for all area 
codes by unchecking the box and clicking OK.) This will allow you to configure most of the table correctly with one action. Once 
you have made this global change, you can configure specific area codes and exchanges individually, using the instructions 
below.  
 
Please note that every time you open the Dialing Rules window, the "Block Long Distance Calls" box will be checked, regardless 
of the actual dialing rules configuration. However, no changes will be made to your Dialing Rules unless you click the "OK" 
button to change to all dialing rules.  
 


 
 
 


HOT TIP - If you click on OK in the reset rules box and the area codes go out of order, click on OK again to get them 
back in order. However, if you click OK after you have configured your dialing rules the way you want them, your 
configurations will be lost.


 
 
Before setting the dialing rules, you need to know the structure of a typical phone number as Teleforms reads it. Using 1 (510) 
655-6200 as an example:  
 


Prefix Area Code Exchange Suffix


1 510 655 6200


 
In the dialing rules, there are 6 columns to be filled out (not all cells need to be completed):  
 
AREACODE - Teleforms has a listing of all the possible area codes in use in the United States. If you block all long distance 
calls, your Teleforms Machine will only work in the area code(s) of your immediate area.  
 
EXCHANGE - This column allows you to limit the specific exchanges of your patrons. For libraries located in large area 
codes that do not want to toll call across the area code, use this configuration to specify which exchanges in your area 
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code should or should not be called.  
 
PREFIX - Enter "1" in this cell if Teleforms will be toll calling across an area code. Instead of entering 1 into each cell, you can 
also click the "Set Dialing Prefix to one" under Reset Rules.  
 
SUFFIX - Usually this cell is empty. Dialing rules are built on a general level. Specific suffixes (i.e. single telephone 
numbers) are controlled within the patron record.  
 
REMOVEAC - If set to True, this rule will remove the area code from the number to be called. It is a useful feature for calls 
made in same area code AND local calling area for the library.  
 
BLOCKCALL - If set to true, this rule will block the calls made to this area code or an area code/exchange combination.  
 
For an example of how these rules will look, see the example below.  
 


 
 
 
In the example, Teleforms will dial every number in the 509 area code.  
 
For area code 510, Teleforms will dial exchange 654 as 1-510-654-XXXX because both the REMOVEAC and BLOCKCALL are 
set as False and the PREFIX is set as 1. It will do the same for exchanges 655, 656 and 657.  
 
For area code 510, Teleforms will dial exchange 658 as 658-XXXX because the REMOVEAC is set to True and the BLOCKCALL is 
set as False. Teleforms will do the same for 659.  
 
For Area Code 510, Teleforms will not dial numbers with exchange 660 because the BLOCKCALL is set to True. For this case, 
REMOVE AC is ignored. 


Because there is not an ANY line for Area Code 510, all of the exchanges not listed (001-653 and 661-999) are 
considered invalid. Adding the ANY line for 510 will provide a generic rule for numbers not covered by the specific exchanges.  
 
For Area Code 517, all exchanges are blocked because the BLOCKCALL is set as True.  
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HOT TIP - To add multiple exchanges to an area code, simply overwrite the area codes on the following lines. You can 
also use the "Insert" button on your computer to add another line; however, any lines added this way show up at the end 
of the list of area codes. If your library will not be calling a certain area code, it does not harm Teleforms to overwrite it 
with an area code/exchange it should be calling.


 
 


HOT TIP - If library system has multiple multiple Teleforms machines, consider placing the machines in locations that 
reduce the number of long distance or toll calls sent by Teleforms. 
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setting the calling days and times


The Teleforms main window must remain open for the program to function. If the window closes, Teleforms will stop making 
phone calls.  
 


BEFORE MODIFING ANY ASPECT OF A LIVE TELEFORMS PC, STOP CALLS BY CLICKING STOP BUTTON 
(UNDER CURRENT STATUS).


 
 
You can customize the day of the week and times you would like Teleforms to start making calls, pause (for example for the 
dinner hour), restart and stop making calls for the day.  
 


 
 
 
Under "Calling Days," check the boxes for the days you would like Teleforms to make calls.  
 


HOT TIP - Since Teleforms operates on a 7-day schedule, not a yearly calendar, your library will have to change the 
calling days prior to a holiday to avoid having Teleforms call your patrons on the holiday, if this is your preference.


 
 
Teleforms understands four required commands for scheduling calls:  
 
Start - Enter the time you would like the system to start making calls. 
Pause - Enter the time you would like the system to pause (ie during the dinner hour). 
Restart - Enter the time you would like the system to restart after the pause. 
Stop - Enter the time you would like the system to stop for the day. 
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The times apply to all days selected. There is not a setting to apply different times to different days.  
 


HOT TIP - If you would like Teleforms to continue dialing throughout the day without a pause, you can configure the 
system to start, pause for a minute, and then restart the next minute.


 
 
After the Calling Days and Calling Times have been set, the status box will inform you of the current status. When the system is 
outside its calling time, the status will read: Not Started. At the start time specified in the Calling Days and Calling Times, 
Teleforms will begin dialing calls.  
 
Once the system is set up, you may leave it on. If at any time you need to make changes to the system, click the Stop button 
(under Current Status). 
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message profile


 


PROFILE_CODE  
HP0 (zero not letter O) is used for hold pickup notices and OD0 is used for overdue notices. For libraries that have purchased 
multiple messages, the code should be specified as HP0[hold mapping code]. For example, if the hold mapping code is west, the 
Profile Code will be HP0west. 


DESCRIPTION  
Enter a brief description of the message. Example: Holds for West Branch 


VOICESEGMENT1  
The first segment of the message. It must be in a .wav file format. For overdues, this segment can include the entire message. 
For hold pickup messages, this is the greeting and the end of this segment should be the patron's name. 


SAYDATEON  
This specifies whether the message includes the date until which the item will remain on hold, as determined by the Time To 
Pickup element in the loan rule table. This should be set for true for holds messages only if you wish the date to be spoken. 


VOICESEGMENT2  
The second segment of the message to be spoken after the name and before the date. It must be in a .wav file format. This can 
be left blank if there is no HoldSeg2.wav message. 


SAYNAMEON  
This specifies whether the message includes the patron name from the patron record. This should be set for true for holds 
messages only if you wish the date to be spoken. 


VOICESEGMENT3  
The third segment of the message to be spoken after the name. It must be in a .wav file format. This can be left blank if there is 
no HoldSeg3.wav message. 


FLIPSAYORDER  
Places the order of the message as: Voice Segment 1, Name, Voice Segment 2, Date, Voice Segment 3. If this element is set to 
false, the Name and Date orders are reversed. 


REPEATMSG  
If you would like the message to repeat once, set this to True. If you would not like the message to repeat, set this to False.  


file:///C|/PROJECTS/LIVE%20Teleforms%20D/print_setting2_5.html (1 of 2) [10/21/2008 3:18:38 PM]



file:///C|/PROJECTS/LIVE%20Teleforms%20D/setting2_7_2.html





Message profile | Teleforms


 


 


close window


file:///C|/PROJECTS/LIVE%20Teleforms%20D/print_setting2_5.html (2 of 2) [10/21/2008 3:18:38 PM]



javascript:window.close()



		Local Disk

		Message profile | Teleforms





		NPFOFACHPAHDEBOFKBCMNDCFECNPEPLE: 

		form1: 

		f1: 












Patron records | Teleforms


 


patron records


Patron records are the key to a functioning Teleforms system. On most Millennium systems there are two variable fields for 
telephone information. The Telephone1 field is generally field tag 't' and the Telephone2 field is generally field tag 'p'. 
The system can potentially use 'p' in some circumstances (see below). 


Patrons may specify telephone in their notice preferences in order to be contacted by Teleforms. This can be done in staff 
mode or in the Web OPAC. When a patron record is opened in staff mode, choose Notice Preference and select phone if the 
patron would like to be contacted via the telephone. The patron record must have a 10-digit phone number (XXX-XXX-XXXX) for 
Teleforms to operate correctly. The dialing rules then determine how to use/not use the 10-digits.  
 


 
 
 
Patrons can also select their own notice preferences using your library's Web OPAC. To allow your patrons to do this, the My 
Millennium feature must be turned on, patrons must be allowed to change their own information though MyMillennium, and the 
patron_notice Web Option must be selected.  
 
For additional information, refer to the Reference Manual, Page # 106380: Notice Delivery Preferences.  
 
Once these options are turned on, patrons can log into their MyMillennium account and choose Modify Personal 
Information. From the window that appears, a patron can choose his or her own notice preference.  
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If a notice preference is not selected, notices default to the following order: email, phone, postal mail. This means that if 
a patron has an email address, a telephone number, and a mailing address, but has not selected a notice preference, 
the notices will be sent via email.  
 
Patrons with a valid telephone number in their record are eligible to receive overdue and hold pickup notices via Teleforms. A 
valid telephone number is one that is in the t (Telephone) field, has 10 digits and not blocked. A block is placed by inserting 
the double pound (##) in front of the telephone number. If a patron has no t field, but does have a valid p (Telephone 2) field, 
then that is used for Teleforms. 


A valid telephone number may contain non-numeric text such as symbols and letters. However, a telephone number with more 
or less than 10 digits will most likely fail and then print later as an unsuccessful (delaying the patron notice).  
 
Patron records can also tell your library when and if Teleforms has contacted a particular patron. This is an option that your 
library can set.  
 
For additional information, refer to the Reference Manual, Page # 106385: Teleforms History.  
 
When this option is turned on, you will see a Teleforms button when in a Patron Record using the Circulation Desk function of 
Millennium.  
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Clicking on this button will bring up a new window that contains that patron's Teleforms history. You can print the 
Teleforms history by clicking print.  
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multiples


Some libraries purchased different configurations of the Teleforms System. If your library did so, the next three pages will guide 
you through the set up of multiple phone lines, multiple messages, and multiple Teleforms systems. 


●     Multiple Phone Lines 
●     Multiple Messages 
●     Multiple Teleforms Systems  
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multiple lines
Teleforms can dial on multiple lines. The number of lines was determined at the time of order. Innovative will have 
configured your system for the number of lines you purchased (between one and eight lines). If your library needs more 
lines than originally purchased, contact Innovative Interfaces. 
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multiple messages


A new Teleforms system arrives with two messages: one for hold pickups and one for overdues. If your library has 
multiple branches, each with its own holdshelf, and you want a hold pickup message for each holdshelf location, this would 
require the purchase of additional messages. Contact Innovative Interfaces to purchase additional messages.  
 
After additional messages have been purchased from Innovative Interfaces, a new menu option to all is available to 
allow editing of the TNS Locations Map File. This file allows for several location codes to be associated with one holds pickup 
location.  
 
Access to this file is in telnet via the Circulation menu path.  
 


 
 
 
Add an Entry  
 
To add an entry, choose A > ADD an entry. For this entry, choose a TNS location code and then add all the location codes for 
this TNS code. The TNS code can be a new arbitrary code and, as seen in the examples above, the TNS codes can be numbers 
or letters.  
 
Change an Entry  
 
If you would like to modify an existing entry, choose C > CHANGE name. You will then be able to modify an entry.  
 
Delete an Entry  
 
Choose D > DELETE an entry if you would like to delete an entry. The system will walk you though picking an entry to delete 
and then you can delete the entry.  
 
Additional information about the TNS Location Map is available in the Guide and Reference on page # 105641 Editing the 
TNS Location Map File. 


Once Innovative has set up the system to work with multiple hold messages, and your library has set the Location Map, your 
library should record the name of the hold pickup location. Follow the instructions on the Recording Messages page of 
this tutorial.  
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HOT TIP - There is a maximum number of 5 characters allowed for TNS Locations.
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multiple machines


If your library has multiple Teleforms PCs, you should use portloca in Options to divide the call load by Locations Served. 
A Teleforms PC will place calls only for those Locations Served entries that it is assigned. For hold pickup notices, the Teleforms 
PC verifies to which Locations Served the pickup location belongs. For overdue notices, the Teleforms PC verifies to which 
Locations Served the patron's home library belongs.  
 
On each Teleforms PC, enter the codes of your Locations Served entry (or entries separated by commas) from your 
Location Served table that the Teleforms PC should serve into the portloca.  
 
For multiple Teleforms PCs, you must ensure that the following conditions are true.  
 


●     all Locations Served entries are assigned to a Teleforms PC 
●     no Locations Served entry is assigned to more than one Teleforms PC 


All Locations Served entries must be entered into only one of the Teleforms PCs. If a Locations Served entry is assigned to 
more than one Teleforms PC, then a patron in that Locations Served could get multiple phone calls for the same hold 
or overdue. If a Location Served entry is not assigned to a Teleforms PC, the system will ignore patrons with overdues and holds 
from that Location Served.  
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using the system


After you have successfully tested your system, you are ready to go live. The following pages will assist you in: 


●     Starting your Teleforms System 
●     Preparing Notices for Teleforms 
●     Monitoring the System 
●     Preparing Notices for Incomplete Calls 
●     Gathering Statitistics 
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starting the system and going 'live'


After you have completed the suggested tests, you are ready to go live. Turn on your system, check the computer's 
clock, Calling Days, and Calling Times, click on Start. You will see the started message in the Current Status box.  
 
Except for some minor maintenance, the system can now be left alone. If you decide to perform any maintenance in the 
future, you must first STOP the calling process, i.e., click the Stop button (under Current Status).  
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preparing notices for teleforms


NOTE: Innovative must turn on the Teleforms Options and you must be authorized to prepare Circulation Notices. For 
additional information, refer to the, Page # 105789: Millennium Circulation Notice Authorizations.  
 
Teleforms needs to have information from the Millennium server in order to start making phone calls. This information 
is provided in the form of the circulation notices that the library prepares on a regular basis. Teleforms will only call patrons with 
Holds and Overdue notices.  
 
For additional information, refer to the Reference Manual, Page # 105690: Preparing Notices.  
 


 
 
 
After the holds and overdue circulation notices have been prepared, you will be given the opportunity to view the notices 
created: email, print and TNS. To view information that could be sent to Teleforms, select TNS from the drop down menu.  
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As with other Circulation notices, you can review this list for accuracy before sending the information to Teleforms. 
Once viewed, click on the "Send" button and the information will be "set-aside" in the Millennium server for Teleforms to access 
when it starts calling patrons.  
 


HOT TIP - You can control what level of overdue notice Teleforms can deliver. At the time of printing circulation 
notices, simply specify which level of overdue notice to send to Teleforms.
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monitoring


The following pages show how to monitor your live system as it is making calls to your patrons. While the your live 
Teleforms System is running, you can monitor the Calling Days Times Statistics and the Calllist.  
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calling days, times, statistics


 
 
During the time the system is dialing, you can view what calls the system is making, will make, and the results of the calls the 
system has already made by scrolling the table on the main Teleforms screen. You may also check the status via the Calling List 
(found under File).  
 
The Call List file is sorted using the following logic: 


1.  Number of call attempts (fewest attempts go first) 
2.  How recent was the last attempt (oldest first) 
3.  Phone number (read as an actual number) 


As calls are made, the software updates the LastResult and Calling Statistics. All of this information is available to be 
downloaded and used for statistical purposes.  
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calling list


The Callling List allows access to Calling List table. This table displays the phone number, name, host id, status, optional say 
date and message to be played. When Millennium Circulation sends notices to "TNS" (Teleforms), the new calls are 
added dynamically to the Calling List. As the system is running, call result information is recorded and displayed. This table can 
be sorted by clicking on any column header, and the data will then be sorted by the selected field.  
 


 
 
 
The information in the Calling List can be viewed in this table or exported for analysis by the library. Please see Statistics 
page of this tutorial.  
 
Another aspect of the Calling List may be found in the File dropdown menu. Here you have the option to set all calls to 
"INCOMPLETE except COMPLETE" or to set all calls to "PENDING except COMPLETE".  
 
Set all to INCOMPLETE: This function will set all calls not yet successfully made to incomplete (as if Teleforms failed to deliver a 
message). It will leave the completed calls as complete (Teleforms did play a message). When setting all calls to incomplete, 
for instances when the phone system is down, the notices may still be printed.  
 
Set all to PENDING: This function will set all future calls to pending (teleforms has not successfully called this number) 
except those that are completed. This option will set the incomplete calls to pending.  
 


HOT TIP - Set all to PENDING can be used for any instance that Teleforms is unable to make a call. Incomplete calls will 
also change to pending.
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incomplete calls


NOTE: You must be authorized for functions 399 (Unsuccessful TNS Overdues) and 400 (Unsuccessful TNS Pickup) before 
you can prepare and generate unsuccessful Teleforms notices.  
 
If Teleforms cannot complete a call after the preset number of tries (set this number in Configure Options), the information will 
be sent back to the Millennium server. These notices can either be printed from the Print Notices function and mailed instead.  
 
To print these notices, login to Millennium Circulation, open Print Notices from the tool bar. Choose either the Unsuccessful 
Overdue or the Unsuccessful Pickup options from the Notice Type drop down menu and follow the same steps for creating 
the notices to be printed.  
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statistics


Besides seeing the number of Completed, Incomplete, Attempts Today, and Not Attempted, Teleforms provides information that 
can be downloaded and used for statistical analysis.  
 
The Calling History table records the results of each call attempted by the Teleforms system and can thus quickly become a 
massive table with thousands of entries. The table records such information as the phone number dialed, patron name, whether 
the call was successful or not, time spent on the phone during the call, and number of attempts before delivering the message. 
This information can either be archived and/or exported into another program (Excel, Statistical Package for the Social Sciences 
(SPSS), etc) for statistical analysis by your library.  
 
For detailed information and screenshots on exactly how to export or archive the information in the Calling History, see Help ; 
Windows Layout ; Reports Menu.  
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The Reports help has detailed instructions and screenshots for exporting or archiving the calling history file. Once exported, the 
library can generate any kind of statistical report it would like.  
 


HOT TIP - Teleforms can slow down if the Calling History file becomes very large. Busy libraries (more than 1000 calls 
per week) should empty this file once every 2 months. Libraries with less than 1000 calls per week may empty the table 
less often.
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